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Before You Begin
This section provides you with safety information, technical sup-
port information, and sources for additional product informa-
tion.

Safety Summary
Your safety is extremely important. Read and follow all warnings
and cautions in this document before handling and operating
Intermec equipment. You can be seriously injured, and equip-
ment and data can be damaged if you do not follow the safety
warnings and cautions.

Do not repair or adjust alone
Do not repair or adjust energized equipment alone under any
circumstances. Someone capable of providing first aid must al-
ways be present for your safety.

First aid
Always obtain first aid or medical attention immediately after an
injury. Never neglect an injury, no matter how slight it seems.

Resuscitation
Begin resuscitation immediately if someone is injured and stops
breathing. Any delay could result in death. To work on or near
high voltage, you should be familiar with approved industrial
first aid methods.

Energized equipment
Never work on energized equipment unless authorized by a re-
sponsible authority. Energized electrical equipment is dangerous.
Electrical shock from energized equipment can cause death. If
you must perform authorized emergency work on energized
equipment, be sure that you comply strictly with approved safety
regulations.
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Safety Icons
This section explains how to identify and understand dangers,
warnings, cautions, and notes that are in this manual. You may
also see icons that tell you when to follow ESD procedures and
when to take special precautions for handling optical parts.

A warning alerts you of an operating procedure, practice,
condition, or statement that must be strictly observed to
avoid death or serious injury to the persons working on the
equipment.

Avertissement: Un avertissement vous avertit d’une
procédure de fonctionnement, d’une méthode, d’un état ou
d’un rapport qui doit être strictement respecté pour éviter
l’occurrence de mort ou de blessures graves aux personnes
manupulant l’équipement.

A caution alerts you to an operating procedure, practice,
condition, or statement that must be strictly observed to
prevent equipment damage or destruction, or corruption or
loss of data.

Attention: Une précaution vous avertit d’une procédure de
fonctionnement, d’une méthode, d’un état ou d’un rapport
qui doit être strictement respecté pour empêcher
l’endommagement ou la destruction de l’équipement, ou
l’altération ou la perte de données.

Note: Notes either provide extra information about a topic or
contain special instructions for handling a particular condition
or set of circumstances.
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Global Services and Support
Warranty Information
To understand the warranty for your Intermec product, visit the
Intermec web site at http://www.intermec.com and click Service
& Support. The Intermec Global Sales & Service page appears.
From the Service & Support menu, move your pointer over
Support, and then click Warranty.

Disclaimer of warranties: The sample code included in this doc-
ument is presented for reference only. The code does not neces-
sarily represent complete, tested programs. The code is provided
“as is with all faults.” All warranties are expressly disclaimed,
including the implied warranties of merchantability and fitness
for a particular purpose.

Web Support
Visit the Intermec web site at http://www.intermec.com to
download our current manuals in PDF format. To order printed
versions of the Intermec manuals, contact your local Intermec
representative or distributor.

Visit the Intermec technical knowledge base (Knowledge Cen-
tral) at http://intermec.custhelp.com to review technical infor-
mation or to request technical support for your Intermec prod-
uct.
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Telephone Support
These services are available from Intermec Technologies.

Service Description

In the U.S.A. and Canada
call 1-800-755-5505
and choose this option

Factory Repair and
On-site Repair

Request a return authorization number for
authorized service center repair, or request an
on-site repair technician.

1

Technical Support Get technical support on your Intermec
product.

2

Service Contract
Status

Inquire about an existing contract, renew a
contract, or ask invoicing questions.

3

Schedule Site Surveys
or Installations

Schedule a site survey, or request a product or
system installation.

4

Ordering Products Talk to sales administration, place an order, or
check the status of your order.

5

Outside the U.S.A. and Canada, contact your local Intermec
representative. To search for your local representative, from the
Intermec web site, click Contact.

Related Documents
This table contains a list of related Intermec documents and
their part numbers.

Document Title Part Number

700 Series Color Mobile Computer Quick Start Guide 962-054-053

700 Series Color Mobile Computer User’s Manual 961-054-031

700 Series Monochrome Computer Quick Start Guide 962-054-061

700 Series Monochrome Mobile Computer User’s Manual 962-054-032

TE 2000 3270 Terminal Emulation Programmer’s Guide 977-055-003

TE 2000 5250 Terminal Emulation Programmer’s Guide 977-055-004

TE 2000 VT/ANSI Terminal Emulatin Programmer’s Guide 977-055-005

The Intermec web site at http://www.intermec.com contains our
documents that you can download in PDF format.

To order printed versions of the Intermec manuals, contact your
local Intermec representative or distributor.
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1About iBrowse

The goal of the iBrowse application is to provide a web browser
for Intermec devices that is compatible with Microsoft Internet
Explorer but does not allow the user to exit out of the browser or
key in a URL to access a non-work related website. It also pre-
vents displaying the onscreen keyboard each time an edit box
receives focus.
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iBrowse Details
iBrowse is a locked-down application for 700 Monochrome
Computers, 700 Color Computers, and CK30 Handheld Com-
puters with standard operating systems that display web pages.
“Locked-down” means that the user does not have the ability to
exit, key in their own URLs, or use the back button. This allows
the web pages to completely define where the user is to go.
iBrowse also prevents the onscreen keyboard from popping up
every time an edit box gets focus. The keyboard is still available
if needed but does not pop up automatically when an edit box
gets focus. You can enter a password to exit the iBrowse applica-
tion, allowing an administrator to modify any necessary system
settings.

A locked-down application is an application that prevents the
user from leaving the application or from accessing the normal
Navigation bar, Command bar, and Start Menu in Pocket Inter-
net Explorer. Locked-down applications are extremely important
to prevent end users from getting “lost” in other parts of the sys-
tem, in preventing users from changing system settings, and to
ensure that users are as productive as possible.

Requirements for Running iBrowse
S iBrowse only runs on a 700 Monochrome Computer, a 700

Color Computer, or a CK30 Computer.

S A data storage card or the Flash File Store must be available
in the 700 Series Computer system. Data storage cards in-
clude a Compact Flash card or a Secure Digital card, depend-
ing on which hardware iBrowse is running. The CK30 Com-
puter does not require a storage card.

S iBrowse requires approximately 450 Kb of free space on the
storage card and approximately 400 Kb of memory space.
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INI File Explained
The INI file associated with iBrowse controls many of the fea-
tures of iBrowse. The home page to navigate to, the password to
exit, and the display of information icons are examples of some
of the options held in the INI file. The INI file can contain
semicolons to act as comments in the INI files. You must save
the INI file as an ASCII file. If you edit the INI file, save it as a
standard ASCII file, not as a Unicode file. The file name of the
ini file is Browse.ini. The INI file must always be in the same
directory as the Browse.exe application. Section names and key
names in the INI file are case-sensitive.

META tags are available to update most INI settings. See “Cus-
tom META Tags for iBrowse” in Appendix A for information.

Admin Section
Note: For the 700 Series Computer, related desktop icons are
shown to the left. For the CK30 Computer, see “Keyboard Na-
vigation” in Appendix C for information on navigating within
the iBrowse application.

There is only one required section in the INI file called the
[admin] section.

Homepage
This key specifies the page to which the iBrowse attempts to
navigate on startup. Tapping the Home icon, on the navigation
bar, also attempts to load the home page, which can be a URL
to the Internet or to the local file system. This key is required.

Password
This key holds the password that allows an administrator to exit
iLaunch and enter the Pocket PC (Windows Mobile) operating
system. This may be necessary if you are modifying system set-
tings. If you leave the password field blank, you can exit the sys-
tem without entering a password. The password in the default
INI is 123456 or 111111 (the sample HTML files can change
the password). If there is a space after the = on the password line
of the INI file, a space becomes the password. If no password is
required, make sure that there is no space after the equal sign.
The password is limited to six characters but keep in mind that
entering more than a few alphabetic characters is extremely diffi-
cult on a Pocket PC device. This key is required.
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F1HelpPage
This key specifies a page to display if the [F1] key is pressed on a
device. The CAB file installs a default help page
(F1HELP.HTML) in the Windows directory. It is recommended
that you install the help page in non-volatile storage on the device.
The [Keys] section of the INI file has the F1HelpKey key that
must be set to TRUE to enable this option.

LinkNotFoundPage
This key specifies a page to display when a user selects to
navigate to a link and that page was not successfully loaded. The
CAB file installs a default “not found” page
(NOTFOUND.HTML) to the Windows directory to allow the
user to reload the page or return to the home screen. Install this
page in non-volatile storage on the device.

DisableHomeCommand
This key enables or disables the Home icon on the navigation
bar. Valid values are TRUE and FALSE. Set this value to TRUE
to prevent the user from navigating to the home page via the
Home icon. The default value is FALSE. This key is optional.

DisableExitCommand
This key enables or disables the Exit icon on the navigation bar.
Valid values are TRUE and FALSE. Set this value to TRUE to
prevent the user from exiting iBrowse via the Exit icon. The de-
fault value is FALSE. See the IBrowse_Command Meta tag for
other ways to exit iBrowse. This key is optional.

DisableOptionsMenu
This key enables or disables the Options item under Tools
menu on the navigation bar. Valid values are TRUE and
FALSE. Set this value to TRUE to prevent the user from enter-
ing the Options dialog. The default value is FALSE. This key is
optional.

Display Section
You can include an optional section named [Display] to display
status indicators on the command bar. Indicators for the current
battery status and signal strength are available. A key is also
available to indicate how often to update the icons on the screen.
The keys and valid values are as follows.



About iBrowse—Chapter 1

5iBrowse User’s Guide

DisplayBatteryStatus
This is the key that shows the battery icon on the command bar.
Valid values for this key are TRUE and FALSE. If this key is
not specified, the default setting is FALSE. For more informa-
tion on the icons and their meaning see Chapter 3, “Running
iBrowse” for more information.

DisplaySignalStrength
Use this key to display an icon on the command bar that indi-
cates the wireless signal strength. Valid values for this key are
TRUE and FALSE. If this key is not specified, the default set-
ting is FALSE. For more information on the icons and their
meanings, see Chapter 3, “Running iBrowse” for more informa-
tion.

UpdateInterval
This key determines how often, in seconds, that iBrowse updates
the battery status and signal strength, in seconds. If this key is
not specified or an invalid value is supplied, the interval is set to
the default of 30 seconds. Valid values are 5 to 120 seconds.

Scanner Section
Note: iBrowse only supports built-in scanners, not tethered
scanner.

You can include an optional [Scanner] section to control certain
aspects of scanning.

UseWedgeMode
This key specifies whether the scanner functions in wedge mode.
Valid values are TRUE and FALSE. FALSE is the default setting
if this key is not found or is not valid.

Setting this value to TRUE causes iBrowse to use the scanner in
wedge mode. This mode enables the scanner on all pages and
“wedges” the data from a valid scan into the keyboard buffer.
This makes it appear as though the scanned data came from key-
board input.

When using this mode, the META tags to enable scanning are
ignored by iBrowse. The META tags to configure scanner
symbologies are still available if the supported symbologies need
to change. Set this value to FALSE to force each web page to
enable scanning via META tags. You cannot change this value
via the downloaded META tags. This key is not required.
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PLSeriesPrinter Section
To print labels to an Intermec® EasyCoder® PL4 Portable
Printer, you must include an optional [PLSeriesPrinter] section.
This section has two required keys, COMPort and BaudRate.

COMPort
This key specifies which COM port to use for printer commu-
nication. For example, to use Bluetooth to communicate to the
printer and COM6 is used by Bluetooth, set the value to
“COM6:”

BaudRate
This key identifies the speed of communication over the port.
Using the previous example, set this value to “57600” for Blue-
tooth.

Keys Section
The [Keys] section is an optional section that can map specific
keys to handle actions such as navigating home and opening
other iBrowse dialogs such as the about dialog, exit dialog, and
options dialog. The section also contains a value to enable the
[F1] help key functionality.

Leaving any option blank results in disabling that option, pre-
venting the user from using that option. The Options and Exit
screens prompt for a password entry before allowing access to
either screen. Any key used in this section are not available for
data entry. For example, if the x key is mapped for exit, the user
is not able to type in a value with an x. Keys mapped using the
Meta tag IBrowse_OnKey preceed these persistent keys.

To remove a mapping that is in the INI file, pass a value of zero
to the appropriate key using the IBrowse_UpdateINI Meta tag.
See Appendix A, “Custom META Tags for iBrowse,” for more
information.

AboutKey
This key specifies a key value that brings up the About screen in
iBrowse.

HomeKey
This key specifies a key value that navigates to the home page.

OptionsKey
This key specifies a key value that brings up the Options screen
in iBrowse. The Password screen is displayed and requires a valid
entry before the options screen is available.
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ExitKey
This key specifies a key value that brings up the Exit screen in
iBrowse. The Password screen is displayed and requires a valid
entry before the user is allowed to exit iBrowse.

F1HelpKey
This key enables the [F1] help key option. Valid values are
TRUE or FALSE. When set to TRUE and the [F1] key is
pressed, the page specified in the [Admin] section F1HelpPage
key is displayed to the user.

Sample INI File

Note: A semicolon is a comment.

[Admin]
;Homepage=file://\SDMMC%20Disk\home.htm
;Homepage=http://www.yahoo.com
Homepage=file://\windows\ibrowse\home.html
F1HelpPage=file://\windows\ibrowse\f1help.html
LinkNotFoundPage=file://\windows\ibrowse\notfound.html
Password=123456
DisableHomeCommand=false
DisableExitCommand=false
DisableOptionsMenu=false

[Display]
DisplayBatteryStatus=true
DisplaySignalStrength=true
UpdateInterval=30

[PLSeriesPrinter]
COMPort=COM6:
BaudRate=57600

[Scanner]
UseWedgeMode=false

[Keys]
;F2
HomeKey=0x71
;F3
OptionsKey=0x72
;F4
ExitKey=0x73
;F5
AboutKey=0x74
;will the F1 key bring up a help page
F1HelpKey=true
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iBrowse Connectivity Messages
iBrowse requires a network connection to provide real-time web
browsing. As a result, iBrowse issues network-specific messages
when it has difficulty accessing the network.

“A Wireless network is not currently available”
This message is displayed when iBrowse starts running if
iBrowse is unable to get signal strength from the 802.11 access
point. Press OK to continue. This is an informational message
only. The user should move to an area with better signal
strength to allow web browsing.

”This device is not currently connected to the network. To
continue searching for a network select OK. To cancel and
continue with no network select Cancel.”
This message can display on startup or when attempting to navi-
gate a web page. This can display even when there is full signal
strength because a connection to the access point does not guar-
antee a connection to the network that is hosting the web server.

Press OK to temporarily put iBrowse on hold while it searches
for a network. If no network is found the same message is dis-
played again. If a network is found, the message “A Network has
been found” is displayed.

Press Cancel for iBrowse to continue as if it had a valid connec-
tion to the network. In the background, it continues to search
for a network but does not display a message when the network
is found.

One common issue that causes this message to display is either
not having a valid IP address or entering an invalid IP address
for the gateway on the device.

”A Network has been found. Press OK to continue.”
This message is displayed after the “This device is not currently
connected to the network” message if OK was pressed to keep
searching for a network and a network was found. Press OK to
continue using iBrowse.

”An IP Address has not been assigned to this device.”
This message is displayed on application startup if no IP address
was assigned to the device. Press OK for iBrowse to continue
without a valid IP address. This message may display if the de-
vice could not be assigned a DHCP IP address or if the device is
set up to use static IP addressing and no IP address was entered.
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2Installing iBrowse

These instructions explain how to install the iBrowse application
onto your 700 Series Mobile Computer and configure the 700
Series Computer for maximum performance.

For help with installing a storage media card, or a battery pack,
or to learn about booting the 700 Series Computer, see the 700
Series Monochrome Mobile Computer Quick Start Guide (P/N:
962-054-061) or the 700 Series Color Mobile Computer Quick
Start Guide (P/N: 962-054-053).

Note: For the CK30 Handheld Computer, the iBrowse applica-
tion is preinstalled in your unit, thus installation is not neces-
sary. To update the INI file on a CK30 Computer, go to the
“\CK_FSS\IBROWSE” location.
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Copying the CAB File
Note: When “DataCard” is mentioned, it references the folder
name of the card you have installed in the device. This is usually
“SDMMC Disk” or “Storage Card.”

Copy the IBROWSE.CAB file to the “DataCard\CabFiles”
folder on the 700 Series Computer. Warm-boot the device to
install the CAB file automatically.

If the “CabFiles” folder is not already on the “DataCard.” it
may be necessary to create a “CabFiles” folder and install the
“2577” directory that allows for automatic cab file extraction
from the appropriate tools CD.

Do not tap on the CAB file via File Explorer to extract the file.
This deletes the CAB file. Extracting the CAB file automatically
on a reboot leaves the CAB file on the 700 Series Computer for
future extractions in the event of a cold-boot.

The default INI file installed by the CAB file points to a sample
web page that was installed to the 700 Series Computer. You
need to change this INI file to point to your preferred homepage
and to set up a password.

To update the INI file, copy the default INI file from the 700
Series Computer to your desktop, either with Microsoft Active-
Sync or by removing the storage card from the 700 Series Com-
puter and putting it into a card reader. In either case, the INI
file is in the “DataCard\IBrowse” directory.

When changing the INI file it is important to not change the
case or spelling of any of the section names or key names. Sec-
tion names are contained in the [ ] brackets and key names are
on the left side of the = equal sign. You can use most any text
editor to modify the INI file, such as Notepad. When saving the
INI file, save it as a standard ASCII file if that is the option.

Copy the modified INI file back to the storage card or back to
the 700 Series Computer via ActiveSync.
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Installing the iBrowse Application
Consider any of the following options to load your iBrowse ap-
plication onto your 700 Series Computer.

S Microsoft ActiveSync

S FTP Server (page 16)

S Secure Digital or CompactFlash storage card (page 17)

Using Microsoft ActiveSync
For the 700 Series Monochrome Computer, go to the next para-
graph.

For 700 Series Color Computer instructions, go to page 13.

700 Monochrome Computer

Note: These instructions assume that the 700 Monochrome
Utilities portion of the 700 Series Monochrome Software Tools
CD was installed onto your desktop.

The Microsoft ActiveSync tool is located on the 700 Mono-
chrome Companion CD. See the 700 Series Monochrome Mobile
Computer User’s Manual (P/N: 961-054-032) for information
about this tool as provided by Microsoft Corporation.

This can be a serial, USB, Ethernet, InfraRed, or 802.11b Acti-
veSync connection. Files can then be copied using File Explorer
on a PC or a laptop computer. This option is usually only good
when updating a few 700 Series Computers.

These instructions assume that Microsoft ActiveSync was
installed onto your desktop computer and is up and running. If
not, see the 700 Series Monochrome Mobile Computer User’s
Manual for an URL from which you can download the latest
application.

1 Connect your 700 Series Computer to your desktop comput-
er via an ActiveSync cable or IrDA.
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2 Wait for a “Connected” message to appear in the Microsoft
ActiveSync application to signal a connection to the 700 Se-
ries Computer. If necessary, select File > Get Connected to
initiate a connection.

3 Click Explore to access the Mobile Device directory on your
700 Series Computer.

4 From your desktop, select Start > Windows Explorer, then
browse the “C:\Program Files\Intermec\TE2000” path for the
IBROWSE.CAB file needed for your 700 Series Computer.
Select this file, right-click the file for a pop-up menu, then
select Copy.

5 Within the Mobile Device directory, select My Pocket PC >
Storage Card > cabfiles.

6 Do a right-click for a pop-up menu, then select Paste.

7 When all of the files are pasted, perform a warm-boot on the
700 Series Computer. When the computer reboots, the newly
copied CAB file automatically activates its utilities.
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700 Color Computer

Note: These instructions assume that the 700 Color Manage-
ment Tools portion of the 700 Series Color Software Tools CD
was installed onto your desktop.

The Microsoft ActiveSync tool is located on the 700 Color
Companion CD, which contains Microsoft products, such as
Outlook and ActiveSync. See the 700 Series Color Mobile Com-
puter User’s Manual (P/N: 961-054-031) for information about
this tool as provided by Microsoft Corporation.

This can be a serial, USB, Ethernet, InfraRed, or 802.11b Acti-
veSync connection. Files can then be copied using File Explorer
on a PC or a laptop computer. This option is usually only good
when updating a few 700 Series Computers.

These instructions assume that Microsoft ActiveSync had been
installed onto your desktop computer and is up and running. If
not, see the 700 Series Color Mobile Computer User’s Manual for
an URL from which you can download the latest application.

1 Connect your 700 Series Computer to your desktop comput-
er via an ActiveSync cable or IrDA.
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2 Wait for a “Connected” message to appear in the Microsoft
ActiveSync application to signal a connection to the 700 Se-
ries Computer. If necessary, select File > Get Connected to
initiate a connection.

3 Click Explore to access the Mobile Device directory on your
700 Series Computer.

4 From your desktop, select Start > Windows Explorer, then
browse the “C:\Program Files\Intermec\TE2000” path for the
IBROWSE.CAB file needed for your 700 Series Computer.
Select this file, right-click the file for a pop-up menu, then
select Copy.

5 If you are using a Secure Digital storage card,
within the Mobile Device directory, select My Pocket PC >
SDMMC_Disk > cabfiles.

If you are using a CompactFlash storage card,
within the Mobile Device directory, select My Pocket PC >
Storage Card > cabfiles.
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6 Do a right-click for a pop-up menu, then select Paste. If you
are using a CompactFlash storage card, skip to step #8.

7 If you are using a Secure Digital storage card,
create a subdirectory called “\2577” in the “SDMMC_Disk”
folder on the Secure Digital storage card. Copy the
AUTORUN.DAT, AUTORUN.EXE, and
AUTOCAB.EXE files to this subdirectory. These files are
located on your desktop in the “C:\Program
Files\Intermec\TE2000” folder.

8 When all of the files are pasted, perform a warm-boot on the
700 Series Computer. When the computer reboots, the newly
copied CAB file automatically activates its utilities.

Add/Remove Programs
If the AutoStart Microsoft’s CE Application Manager option
was checked to be installed onto your desktop, the following
appears upon completion of your installation.

Check the items to be installed onto your 700 Series Computer,
then click OK to continue.
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Using the FTP Server
The 700 Series Computer has a built-in FTP Server that con-
nects to a network via Ethernet or 802.11b. This allows connec-
tions to the 700 Series Computer to perform file transfers or
computer management functions. You can also create FTP
scripts to automate the process of copying files to the 700 Series
Computer. This option is good for when a large number of 700
Series Computers need to updates. See the 700 Series Color Mo-
bile Computer User’s Manual or the 700 Series Monochrome Mo-
bile Computer User’s Manual for information.

The following sample FTP scripts installed in the
“C:\Program Files\Intermec\TE2000” location on your desktop
via the TE 2000 Installation CD:

S The TE2000_FTP_CFCARD.BAT script file is for the Com-
pactFlash storage card.

S The TE2000_FTP_SDCARD.BAT script file is for the Se-
cure Digital storage card (700 Color Computers only).

Or, use the VisualBasic script files to send the IBROWSE.CAB
file to your 700 Series Computer. From your desktop, do this:

S If you are using a CompactFlash storage card,
select Start > Programs > Intermec > TE2000 > ftp >
TE2000_FTP_CFCard to initiate this transfer.

S If you are using a Secure Digital storage card (700 Color Com-
puters only), select Start > Programs > Intermec > TE2000 >
ftp > TE2000_FTP_SDCard to initiate this transfer.

Enter the IP address of the 700 Series Computer to receive files,
then click OK to initiate the file transfer. An MS-DOS dialog
box appears to list the progress of the file transfer. When com-
plete, the MS-DOS dialog box closes automatically and the 700
Series Computer performs a warm-boot.
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Using a Storage Card
Use the following steps to install an application using a storage
card.

Copying to a CompactFlash Storage Card

Note: You can use a CompactFlash storage card on either the
700 Monochrome Computer or the 700 Color Computer.

Follow the steps below to install the iBrowse application on the
device using a CompactFlash storage card:

1 Suspend the 700 Series Computer and remove its Compact-
Flash drive, which holds a storage card.

2 Using a CompactFlash Adapter card, place the CompactFlash
Drive in your desktop PC card drive.

3 In the “\Storage Card” folder, create a subdirectory called
“\CabFiles” on the PCMCIA CompactFlash drive in which
to store the CAB files.

4 Copy the CAB files to the “\CabFiles” subdirectory created
on the CompactFlash drive.

5 Remove the CompactFlash drive from your desktop comput-
er and reinstall it into the 700 Series Computer.

6 Warm-boot the 700 Series Computer to automatically extract
these files.

Copying to a Secure Digital Storage Card

Note: You can only use a Secure Digital storage card on the 700
Color Computer.

Do the same steps as for the CompactFlash storage card, except
replace steps 5 and 6 with the following:

S In the “SDMMC_Disk” folder, create a subdirectory called
“\2577” on the Secure Digital storage card.

S Copy the AUTORUN.DAT, AUTORUN.EXE, and
AUTOCAB.EXE files to this subdirectory. These files are
located on your desktop in the “C:\Program
Files\Intermec\TE2000” folder.
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3Configuring iBrowse

Before providing an updated device to the user, a device admin-
istrator must properly set up the device. Go to the next page to
configure the 700 Series Computer or to page 30 to configure
the CK30 Handheld Computer.
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Configuring the 700 Series Computer
Before providing an updated 700 Series Computer to the user, a
device administrator must properly set up the 700 Series Com-
puter.

Note: Instructions are written for both Pocket PC 2002 and
Windows Mobile 2003 operating systems.

Go to page 25 for Windows Mobile 2003 instructions.

Pocket PC 2002 Instructions
The following instructions pertain to the Pocket PC 2003 oper-
ating system. See Revision C of the 700 Series Color Mobile
Computer User’s Manual P/N: 961-054-031 or Revision A of the
700 Series Monochrome Mobile Computer User’s Manual P/N:
961-054-032 for more information about this operating system.

Setting the Appropriate IP Addresses or DHCP Settings
These instructions modify the 802.11b Wireless LAN. There are
other variables that may need setting up to get on a network.
Contact your Intermec representative for more information.

1 On the 700 Series Computer, tap Start > Settings > the Con-
nections tab > Network Adapters. If you need to enter spe-
cific server information, tap the 802.11b Wireless LAN
adapter for its properties.



Configuring iBrowse—Chapter 3

21iBrowse User’s Guide

2 To change the IP addresses, tap Use specific IP address, then
enter the appropriate IP addresses.

3 To change the DHCP addresses, tap the Name Servers tab,
then enter the appropriate addresses.

4 Tap ok to save and exit 802.11b Wireless LAN properties.
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Setting the Appropriate Wireless Network Settings

Note: See the 700 Series Color Mobile Computer User’s Manual
for information about the Profile Wizard.

1 On the 700 Series Computer, tap Start > Settings > the Sys-
tem tab > Wireless Network to access the Profile Wizard.

2 Use the Profiles page to add, edit, or delete multiple net-
working environments for this 802.11b radio. To add a
profile from this screen, enter up to 32 alphanumeric
characters in the Profile field, then tap Add.

3 To edit a profile, select an existing profile from the
Profile drop-down list, tap Edit, make the changes
needed for this profile (starting in the next paragraph),
then tap OK to return to the Profiles page.

4 To delete a profile, select a profile from the Profile drop-
down list, tap Delete, then tap Yes to remove the se-
lected profile.

5 Tap ok to save your changes and exit the wizard.
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Setting the Appropriate Connection Method
1 On the 700 Series Computer, tap Start > Settings > the Con-

nections tab > Connections, then set network card connects
to to “the Internet”.

1 On the 700 Series Computer, tap Start > Settings > the Con-
nections tab > Connections.

2 Select “The Internet” from the My network card connects to
drop-down list.

3 Tap ok twice to save your changes and exit Connections.
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Saving the System Configuration
Use the RegFlushKey() API to save the system configuration, via
the registry, if desired.

If you are using the RegFlushKey() API, the application must
use a special API to make sure the registry is written to the ap-
propriate card; or you can use the Utilities control panel applet,
as follows. See Appendix A, “Configurable Settings,” for more
information about this applet.

1 From the 700 Series Computer, tap Start > Settings > the
System tab > the Utilities icon > the Registry Save tab.

2 Tap Enable Registry Storage, tap either of the following:

S SD to write the registry to the Secure Digital storage card.

S CF to write the registry to the CompactFlash storage card.

Note: In software builds 1.30 or later, there is a third option,
FL, for the Flash File Store — do not select this option. Con-
tact your Intermec representative for more information.

3 Tap ok to save your entry and exit the Utilities control panel
applet.
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Windows Mobile 2003 Instructions
The following instructions pertain to the Windows Mobile 2003
operating system. See Revision E of the 700 Series Color Mobile
Computer User’s Manual P/N: 961-054-031 for more informa-
tion about this operating system.

Setting the Appropriate IP Addresses or DHCP Settings
These instructions modify the 802.11b Wireless LAN. There are
other variables that may need setting up to get on a network.
Contact your Intermec representative for more information.

4 On the 700 Series Computer, tap Start > Settings > the Con-
nections tab > Connections > the Advanced tab > Network
Card.

5 Tap the Network Adapters tab. If you need to enter specific
server information, tap the 802.11b Wireless LAN adapter for
its properties.
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6 To change the IP addresses, tap Use specific IP address, then
enter the appropriate IP addresses.

7 To change the DHCP addresses, tap the Name Servers tab,
then enter the appropriate addresses.

8 Tap ok to save and exit 802.11b Wireless LAN properties.
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Setting the Appropriate Wireless Network Settings

Note: See the 700 Series Color Mobile Computer User’s Manual
for information about the Profile Wizard.

1 On the 700 Series Computer, tap Start > Settings > the Sys-
tem tab > Wireless Network to access the Profile Wizard.

2 Use the Profiles page to add, edit, or delete multiple net-
working environments for this 802.11b radio. To add a
profile from this screen, enter up to 32 alphanumeric
characters in the Profile field, then tap Add.

3 To edit a profile, select an existing profile from the
Profile drop-down list, tap Edit, make the changes
needed for this profile (starting in the next paragraph),
then tap OK to return to the Profiles page.

4 To delete a profile, select a profile from the Profile drop-
down list, tap Delete, then tap Yes to remove the se-
lected profile.

5 Tap ok to save your changes and exit the wizard.
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Setting the Appropriate Connection Method
1 On the 700 Series Computer, tap Start > Settings > the Con-

nections tab > Connections, then set network card connects
to to “the Internet”.

1 On the 700 Series Computer, tap Start > Settings > the Con-
nections tab > Connections > the Advanced tab > Network
Card.

2 Tap the Network Adapters tab. Select “The Internet” from
the My network card connects to drop-down list.

3 Tap ok twice to save your changes and exit Connections.



Configuring iBrowse—Chapter 3

29iBrowse User’s Guide

Saving the System Configuration
Use the RegFlushKey() API to save the system configuration, via
the registry, if desired.

If you are using the RegFlushKey() API, the application must
use a special API to make sure the registry is written to the ap-
propriate card; or you can use the Utilities control panel applet,
as follows. See Appendix A, “Configurable Settings,” for more
information about this applet.

1 From the 700 Series Computer, tap Start > Settings > the
System tab > the Utilities icon > the Registry Save tab.

2 Tap Enable Registry Storage to save the registry in the Flash
File System (PSM) via the “\Flash_File_Store\Registry” path.

3 Tap ok to save your entry and exit the Utilities control panel
applet.



Configuring iBrowseChapter —3

30 iBrowse User’s Guide

Configuring the CK30 Handheld Computer
Before providing an updated CK30 Computer to the user, a de-
vice administrator must properly set up the CK30 Computer.

1 On the CK30 Computer, press green C, then orange B, to
access the System Main Menu, then press [1] for the Config-
uration Utility.

2 Press [2] to configure the communications.

3 When done configuring communications, press [Esc] to re-
turn to the Configuration Utility. See your Intermec repre-
sentative for more information about these communications.

4 Press [6] to save these settings to flash, to preserve these set-
tings during a cold-boot procedure.



31iBrowse User’s Guide

4Running iBrowse

The iBrowse application does not start up automatically.

Go to the next page for information on starting up iBrowse on
your 700 Series Computer.

Go to page 36 for information on starting up iBrowse on your
CK30 Handheld Computer.
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700 Series Computers
To start iBrowse, tap Start > Browse. If you need iBrowse to
start automatically, you can create a shortcut to it in the
“\Windows\Startup” folder. You can also add an
AUTOUSER.DAT file to the “\DataCard” folder in the system.

For information on how to use AUTOUSER.DAT file, see your
technical documentation for your device or contact Customer
Support.

The following information pertains to both the 700 Mono-
chrome Computer and the 700 Color Computer.

Navigation Bar
Below is a sample of the navigation bar in iBrowse.

Tools Menu
Under the Tools Menu, you can look at copyright information
or change the home page.

About
Tap Tools > About to view the following copyright information
for iBrowse (About). Tap OK to close.
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Options
Tap Tools > Options to change the home page iBrowse is to
use. The same password required to exit the application is also
required to enter the Options page.

Icons
These standard icons are not needed by most users as their web
pages actually control the application flow. Additional icons can
appear in the right-hand side of the navigation bar to indicate
battery level and radio signal strength. See “The INI File Ex-
plained” in Chapter 1 or “Custom META Tags for iBrowse” in
Appendix A for information on how to enable and disable icons.

Tap the Home icon to start back at the default home page.

Tap the Keyboard icon to bring up and put away the pop-up
keyboard. When you need to enter alphabetic information, tap
this icon to display the onscreen keyboard. Special consider-
ations were added to iBrowse so the onscreen keyboard only ap-
pears when you tap the keyboard icon. HTML files do not need
modification to prevent the keyboard from appearing automati-
cally.

Tap Exit to access a Password dialog through which those with a
password can exit iBrowse. The password is set up in the
BROWSE.INI file.
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Battery and Signal Strength Icons

The following Battery and Signal Strength icons are available for
the navigation bar:

Battery Icons
The battery has approximately 100–80% of capacity (green).

The battery has approximately 80–60% of capacity (green).

The battery has approximately 60–40% of capacity (green).

The battery has approximately 40–20% of capacity (red).

The battery has approximately 20–0% of capacity (red exclama-
tion point).

The battery is currently charging (blue with yellow bolt).

Unknown — The battery status is not available (blue question
mark). If this icon persists for several minutes, there may be a
problem with the battery.

Signal Strength Icons
Excellent — An excellent connection exists between the wireless
radio and the access point (three green cells).

Average — An average connection exists between the wireless
radio and the access point (two green cells).

Poor — A poor connection exists between the wireless radio and
the access point. You should move closer to the access point to
prevent losing a connection (one green cell).

Unavailable — Wireless network is currently unavailable. This
occurs if the device is out of range of the access point or if the
wireless network drivers are not loaded (red antenna).

Note: Signal strength only indicates there is a connection be-
tween the wireless radio and an access point. The device can
connect to the wrong access point if the wireless connection is
not set up properly. Also, if the device is connected to the cor-
rect access point, it still may not connect to the network if the
devices network settings were not properly configured.
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Uninstalling iBrowse
No automatic uninstallation is available at this time. To unins-
tall iBrowse, remove the following files:

\windows\start menu\Browse.lnk
\windows\IBrowse\*.*
DataCard\IBrowse\*.*
DataCard\Cabfiles\IBrowse*.cab

where DataCard is the folder name of the card you have
installed in the device. This is usually “SDMMC Disk” (Com-
pactFlash) or “Storage Card” (Secure Digital).

TE Version of iBrowse
The Terminal Emulation (TE) version of iBrowse is slightly
modified from the regular version. The TE version comes with
an INI file that does not require a password to exit.

The TE version also enables the application keys (A1–A4),
which are are set up by the iLaunch application. Press [A1] to
start TE 2000, press [A2] to start iBrowse, press [A3] or [A4] to
start iLaunch.
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CK30 Handheld Computers
To start iBrowse, do the following:

1 Press Green C, then Orange B, on the CK30 keypad to
access the System Main Menu.

2 Press [3] to access your programs.
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3 Select the iBrowse application. Note that the option number
may change depending on what applications are installed on
your CK30 Computer.

Navigation Bar
The navigation bar is not available on CK30 Computers.
iBrowse leaves the standard menu bar at the bottom of the
screen to show signal strength, battery, and keyboard informa-
tion (like shift state).

Menu Bar
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Keyboard Navigation
To navigate on the CK30, keymappings are added to the INI
file to perform the same functions as on the 700 Series Comput-
er navigation bar. These key mappings are not limited to the
CK30 Computer, they may also be used on the 700 Series Com-
puter if keyboard navigation is desired. See the [Keys] section of
the INI file for information on setting up specific keys for these
functions.

Key Description

About Use the AboutKey value in the INI file to enable a key press to
bring up the About screen. The default setting for this is [F5].

Options Use the OptionsKey value in the INI file to enable a key press to
bring up the Options screen. The password screen is displayed first
to prompt for the correct password before continuing. The default
setting for this is [F3].

Exit Use the ExitKey value in the INI file to enable a key press to bring
up the Exit screen. The password screen is displayed first to prompt
for the correct password before continuing. The default setting for
this is [F4].

Home Use the HomeKey value in the INI file to enable a key press to
navigate to the Home page. The default setting for this is [F2].
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Battery and Signal Strength Icons
The following Battery and Signal Strength icons are available for
the CK30 Computer:

Battery Icons
The battery is half full. You should work for several more hours
before changing batteries.

The battery is low. You need to replace this soon.

The battery is critically low. You need to replace this now.

The backup battery is low.

Signal Strength Icons
Strong connection to the access point.

Good connection to the access point.

Weak connection to the access point.

No connection to the access point.

Note: Signal strength only indicates there is a connection be-
tween the wireless radio and an access point. The device can
connect to the wrong access point if the wireless connection is
not set up properly. Also, if the device is connected to the cor-
rect access point, it still may not connect to the network if the
devices network settings were not properly configured.
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Uninstalling iBrowse
No automatic uninstallation is available at this time. To unins-
tall iBrowse, do the following:

1 On the CK30 Computer, press green C, then orange B, to
access the System Main Menu, then press [2] to access the
File Manager.

2 Press the appropriate number for the “CK_FSS” directory,
then the appropriate number for the “Persistent Copy” direc-
tory. Depending on how your system is configured, press [7]
or the U or D keys to scroll to and highlight the
CK30Ibrowse.cab file. Press the following keys to delete this
file.

S On 52-key and 42-key keyboards, press [Green] C A

S On 50-key keyboards, press [Func] [Green] C

Below is the path to this file:
\CK_FFS\Persistent Copy\CK30Ibrowse.cab

3 Press [1] to go back to the previous screen, then press the ap-
propriate number to access the “Windows” directory. Press
the U or D keys to scroll to and highlight the “IBrowse” di-
rectory. Press the following keys to delete this directory:

S On 52-key and 42-key keyboards, press [Green] C A

S On 50-key keyboards, press [Func] [Green] C

Below is the path to this directory:
\CK_FFS\Persistent Copy\Windows\IBrowse
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4 Press [Esc] twice to back up to the “CK_FFS” directory, then
press the U or D keys to highlight the “IBrowse” directory.
Press the following keys to delete this directory:

S On 52-key and 42-key keyboards, press [Green] C A

S On 50-key keyboards, press [Func] [Green] C

Below is the path to this directory:
\CK_FFS\IBrowse

5 Press [Esc] to back up to the root directory, press [7], then
the appropriate number to move to the “Windows” directory.
Press the U or D keys to highlight the “IBrowse” directory,
then press the following keys to delete this directory:

S On 52-key and 42-key keyboards, press [Green] C A

S On 50-key keyboards, press [Func] [Green] C

Below is the path to this directory:
\Windows\IBrowse

Note: You could use the following step to restore the registry to
its default settings, but this does remove changes from all ap-
plications that have modified the registry. Therefore, only use
step 6 if you need to restore the device to its initial state.

6 Do the following to restore the device to its initial state:

a Press [Esc] twice to return to the System Main Menu, then
press [1] to access the Configuration Utility.
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b Press [5] to restore the defaults.

c Press [Enter] to continue. The CK30 then shuts down.
You will have to power the unit back on.

TE Version of iBrowse
The Terminal Emulation (TE) version of iBrowse is not avail-
able for the CK30 Computer.

Printing With the LinePrinter ActiveX Control
In addition to META tag printing to Intermec PL3 Portable
Printers, it is possible to print to all Intermec mobile printers via
the Line Printer ActiveX control. For more information on
printing to a PL3 Printer, see “The INI File Explained” in
Chapter 1 and “Custom META Tags for iBrowse” in Appendix A.

The version of the LinePrinter ActiveX control that prints from
a web page is not currently available in a released tool kit. To
download the latest version and a sample print page go to:
http://www.intermec.com/developersupport.
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Scanning From iBrowse
Note: iBrowse only supports built-in scanners, not tethered
scanners.

Three different methods for scanning are available. Use care
when deciding which method to use because it can have an im-
pact on how the web pages are designed. The three methods are:

Wedge You can press the trigger for the scanner at any time to display the aiming
beam. If a valid bar code is successfully decoded, the data returned is
wedged into the keyboard buffer. The control with the current focus re-
ceives the data. You do not have to add unique Intermec tags or code to
the HTML page for this mode. Set the UseWedgeMode key in the INI
file to TRUE and any <input> text box is able to get the scanned data
when it has focus. NOTE: You must use this mode if the web pages where the
user need to scan contain bookmarks or frames.

META Tags When using the META tag method, the scanner is disabled when iBrowse
starts and is enabled on a page-by-page basis. In addition, you can use the
META tags to automatically pass the scanned data to another web page, to
a JavaScript function, or to continually fire and receive data from the scan-
ner. If the wedge mode is enabled, automatic enable and disable of the
scanner does not function but you can still enter data into the control from
wedge mode. For more information on this method of scanning, see “Cus-
tom META Tags for iBrowse” in Appendix A.

ITCAXEdit ActiveX control iBrowse installs a custom ActiveX edit control that is used from within
web pages in place of <input> tags. This control has a property that
enables the scanner on a field-by-field basis. When the control loses focus,
the scanner is disabled. If the wedge mode is enabled, this mode does not
function but you can still enter data into the control from wedge mode.
For more information on this method of scanning, see the
ENABLESCANNER function in “Using the ITCAXEdit Control on a Web
Page” in Appendix B.
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Designing Web Pages for iBrowse
Some key things to consider when designing web pages for
iBrowse.

S iBrowse is based on Pocket Internet Explorer which supports
the following technology versions:

S HTML V3.20

S JavaScript 1.2

S ActiveX components

S XML and XSL

S WML

S CK30 Computers and devices with Pocket PC (Windows
Mobile) 2003 support the following:

S HTML V4.01

S Extensible HTML (XHTML)

S Cascading style sheets

S Microsoft JScript version 5.5

S Enhanced scripting and Document Object Model support

S Wireless Markup Language (WML) 2.0 (XHTML +
WML 1.x)

S Internet Protocol version 6 (IPv6) in IPv4/IPv6 mixed-
mode environments

S Force the user to follow a specific path. In most situations,
the HTML should lead the user through a narrow path for
entering or processing information. Pages designed for the
desktop browser usually have dozens of links on each page
providing a user a myriad of paths on which to continue. In
the business environment, it is usually more useful to force
the user down a select path so a full set of information is
gathered. The limited screen area is also a factor in providing
a limited number of links.
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S Limited Screen space. Because of the limited screen area on
Pocket PC (Windows Mobile) devices, design screens and
images to fit the display. The area that iBrowse has to display
a web page on 700 Series Computers is approximately 235
pixels wide by 290 pixels high if there are no scroll bars on
the screen. When scroll bars are added, the number of pixels
is decreased by about 15 (220x275).

For CK30 Computers, the area to display is approximately
160 pixels wide by 140 pixels high.

S Throughput. In a wireless environment, throughput is af-
fected by signal strength. The lower the signal strength from
the access points, the slower the throughput. For this reason,
it is best to design the pages as small as possible. Use graphics
sparingly. Find ways to split large pages into two or more
pages that the user can step through. This prevents the user
from long waits when they are in a low coverage area. Opti-
mally, the pages are transferred at 11 Mbps but they can also
be as low as 2 Mbps.

S Frames and Bookmarks. Due to the limited screen space and
throughput concerns, frames and bookmarks are not recom-
mended. A page that has two frames actually ends up down-
loading three different web pages. A page with bookmarks
may be set up to show the users several different views of data
or provide several different forms to fill. This page takes lon-
ger to download and the scroll bar that is at the side of the
screen could easily confuse a new user if they accidentally
scroll to a different section of the page. META tags that work
on a per-page basis do not function in frame and bookmark
pages.
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S Keyboard versus stylus input. When possible, the user should
navigate through the web pages using the keypad because it is
more convenient and efficient. The stylus is often lost by us-
ers, which then requires the use of a finger or another object
as a stylus. These substitutes are rarely small enough to tap on
the correct item without several tries. You can set the META
Tag OnKey feature keys on the keypad to run a Javascript or
navigate to a new page with a single keystroke. You can set
up a screen full of links like a menu so each link is assigned a
number. The user could then press that number on the key-
pad instead of having to tap on the screen. When a user is
required to tap on the screen, make sure the button or link is
large enough for easy selection with a finger.

S Pages designed to fit on the screen. Because of the limited
screen space, throughput, and difficulties scrolling with the
scroll bars provided, design each page to fit on the screen
without showing the scroll bars.

Evaluation Version of iBrowse
Evaluation versions of iBrowse are available. These versions al-
low some restricted use. The iBrowse application performs nor-
mally with the exception that it occasionally brings up a remind-
er that the version of iBrowse used is only an evaluation version.

You have 60 days from the date you first start using the evalua-
tion version of iBrowse to either purchase a license or quit using
iBrowse. If you decide to purchase licenses for iBrowse, please
contact your Intermec representative.

A license is required for each device that runs iBrowse. The part
number to purchase a single license is 235-106-001. Before a
full version is delivered, you must contact Purchasing and fill
out a Purchase Agreement.
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iBrowse Limitations and Restrictions
S iBrowse does not lock down other applications.

S iBrowse does not save the registry to a storage device.

S iBrowse only runs on 700 Monochrome Computers, 700
Color Computers, or CK30 Handheld Computers with stan-
dard operating systems.

S iBrowse may break out of the locked-down mode if the Con-
nection Manger is not set to properly allow a device to con-
nect to the network.

S Although it is believed that iBrowse has the same capabilities
as Pocket Internet Explorer, this may not be so in all situa-
tions. Report any discrepancies between the functionality of
Pocket Internet Explorer and iBrowse.

Troubleshooting iBrowse
When starting iBrowse, the following message is displayed:
Trouble Connecting — Unable to connect with current
settings . . .

S This message is displayed when the device was not properly
configured to connect to the Internet. See Chapter 2, “Instal-
ling iBrowse,” for details on the proper set up for the device.

When starting iBrowse, the wait cursor is displayed and a web
page is never displayed.
S Verify that a valid INI file is in the directory with the iBrowse

application.

S Verify that the device is properly set up to connect to the net-
work. See Chapter 2, “Installing iBrowse” for details on proper
set up for the device. The CORE application on the 700 Se-
ries Computer can help determine whether you are connected
to a network. Contact Customer Support if you need help
connecting to the network.

S When removing the card from the device to update the INI
file, make sure to properly stop or eject the card before re-
moving it from your desktop. The method to do this differs
based on the type of card reader you use.
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iBrowse does not render my web pages the same way as my
desktop version of Internet Explorer.
S This is because iBrowse uses some of the internal code of

Pocket Internet Explorer (PIE). PIE does not support all of
the features and functionality of the desktop version of Inter-
net Explorer.

Jscript/JavaScript does not behave as expected on iBrowse.
Enable scripting error by creating the following key and value.
For more information on this topic, see the Pocket PC SDK
online help, then tap Find to search for “Scripting”.

[HKEY_CURRENT_USER\Software\Microsoft\Internet Ex-
plorer\Main]”ShowScriptErrors”=dword:00000001

When using ActiveX controls, mark the controls as “Safe for
Scripting” when they are compiled. Controls not marked “Safe
for Scripting” are not allowed to run from Jscript. For more in-
formation on this topic, see the Pocket PC SDK online help,
then search for “Declaring Your Control as ‘Safe for Scripting’”.

When starting iBrowse, if a blank screen is displayed:
S Make suree the CK30 Computer is running a standard oper-

ating system.

S Ensure the CK30 Computer is connected to a network.

S Ensure that a gateway or default router is set.

The following message appears when iBrowse is started:
A Wireless network is not currently available

S iBrowse ensures the device has network access before starting
up. If no signal strength is found from the wireless radio,
then this message is displayed. This is an indication that the
wireless network settings were not properly configured.
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Microsoft ActiveSync does not work after installing iBrowse.
S iBrowse disables ActiveSync to help maintain its locked-down

mode. To enable ActiveSync, exit iBrowse, go to Start > Acti-
veSync, then select Tools > Options in the bottom left cor-
ner. In this screen, you can enable ActiveSync. You have to
do this after each time you run iBrowse.

S The Browse.CAB installation file also changes the connec-
tions settings from “work” to “internet” to simplify the pro-
cess of connecting to a network. If a network ActiveSync con-
nection is required, change the connection setting back to
“work”. To do this, go to Start > Settings > the Connections
tab > Connections > the Advanced tab > Network Card >
the Network Adapters tab. Select “Work” from the My net-
work card connects to drop-down list.

Note: These instructions are written for Windows Mobile 2003.

When moving between edit fields on a web page, the onscreen
keyboard disappears and takes several taps on the keyboard icon
to bring it back up.
This is usually because the INPUT tag lacks the type attribute.
To correct this problem, ensure that all <input> tags include
‘type=”text”’. For example <input type=”text”
name=”Field1”size=”12” ID=”Text1”>

Bluetooth does not seem to set up correctly after a cold-boot.
There was an issue with the installation process. Bluetooth
would install its drivers and then required some user interaction
to finish setting it up. In the meantime, iBrowse would install
and tell the device to reboot. This meant Bluetooth was never
installed correctly. This issue was fixed with some updated
system software. Updated versions of AUTORUN.EXE and
AUTOCAB.EXE can be found on the 700 Color Tools CD
version 1.08 or greater or on the Intermec Developer’s Library
CD.

The scanner is enabled on a page on which it should not be
enabled.
Older versions of the 700 Color Computer operating system did
not correctly disable the imager. This is corrected in versions
1.31 and newer. Note that this pertains to built-in scanners, teth-
ered scanners are not supported.
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The scanner is not enabled on a page and it should be.
If using META tags, this issue can occur when a page is made of
frames or bookmarks. The only current options are to use wedge
mode scanning or the ITCAXEdit control for scanning. Note
that this pertains to built-in scanners, tethered scanners are not sup-
ported.

Contacting Customer Support
When contacting Customer Support, be sure to provide the fol-
lowing information:

S Model number of the device

S Version number of the operating system

S Version number of the I_Browse Software

For technical support on your Intermec product, call
1-800-755-5505, then select option 2.

See Before You Begin for additional support information.
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Custom META Tags for
iBrowseA

Some custom META tags were defined for the iBrowse web
browser. These tags allow web pages to enable specific function-
ality in the browser. These tags do not work on web browsers
other than iBrowse. You can specify multiple META tags on
each page. There are two parts to each tag, the “HTTP-Equiv”
and the “content”. The case of the META tags do not prevent
them from incorrect interpretation. Following is a list of all
available tags and information on how to use them.

If META tags are used, the HTML should not use frames or
bookmarks. When navigating to certain frames or to a book-
mark, iBrowse does not read the META tags and so the single
page settings like IBrowse_Scanner is not available.

All sample HTML in this appendix are provided as is. For
working examples of most META tag features, see the sample
HTML files installed by the iBrowse CAB file in the
“\Windows\IBrowse\” folder on your Intermec device.
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IBrowse_Command
When this tag is encountered, the iBrowse application immedi-
ately exits without displaying a password prompt.

Syntax
HTTP-Equiv=”IBrowse_Command”
content=”exit”

Comments
This allows the HTML to control when the user can exit the
application. This tag applies only to the page on which it is lo-
cated.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=” IBrowse_Command” content=”exit”>
</HEAD>
<BODY>

<P>You should not be seeing this right now.</P>
</BODY>
</HTML>
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IBrowse_GetUnitInformation
This tag retrieves valuable information about the unit on which
iBrowse is running. Three items of data are returned in the fol-
lowing order: serial number, UUID (a globally unique Pocket
PC identifier), and current iBrowse version number.

Syntax
HTTP-Equiv=”IBrowse_GetUnitInformation”
content= URL | Javascript function

Comments
The URL or Javascript placed in the content tag is not executed
until the entire page has loaded. This tag applies only to the
page on which it is located.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_ GetUnitInformation”
Content=”file://\windows\infotest..html?serialnum=%s&uuid=%s&appversion=%s”>

<!-or ->
<META HTTP-Equiv=”IBrowse_ GetUnitInformation”

Content=”Javascript:ShowUnitInfo(’%s’, ’%s’, ’%s’);”>
<SCRIPT> LANGUAGE=JAVASCRIPT>
function SetUnitInfo(serial,uuid,version)
{

document.Frm3.Fld1.value = serial;
document.Frm3.Fld2.value = uuid;
document.Frm3.Fld3.value = version;

document.Frm3.Fld1.focus();
}
</SCRIPT>

</HEAD>
<BODY onload=”document.Frm3.Fld1.focus()”>

<form name=”Frm3”>
<table id=”AutoNumber1”>

<tr><td width=”100%”>SerialNumber:</td></tr>
<tr><td width=”100%”><input type=”text” name=”Fld1”

size=”20”></td></tr>
<tr><td width=”100%”>UUID:</td></tr>
<tr><td width=”100%”><input type=”text” name=”Fld2”

size=”50”></td></tr>
<tr><td width=”100%”>Version:</td></tr>
<tr><td width=”100%”><input type=”text” name=”Fld3”

size=”12”></td></tr>
<tr><td width=”100%” colspan=”2”>&nbsp;</td></tr>
</table>
</form>

</BODY>
</HTML>
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IBrowse_OnKey
This changes the action of a particular key. The key mapped is
mapped for the current page only. The key value, 0x1b, in the
following example, can be either a hexadecimal value (0x1b) or a
decimal value (27).

Syntax
HTTP-Equiv=”IBrowse_OnKey0x1b”
content= URL | Javascript function

Comments
The content can include a web page to navigate to or a Java
Script function to perform. This tag affects only the page on
which it is placed, so do any key remapping on a page-by-page
basis. You must precede hexadecimal values by 0x. You cannot
remap system keys such as [A1] in the TE version of iBrowse.

Note: Keys mapped in this method take precedence over persis-
tent keymappings like those done in the [Keys] section of the
INI file.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=” IBrowse_OnKey0x1b” content=”
http://appserver\home.htm”>

<META HTTP-Equiv=” IBrowse_OnKey032” content=”
http://appserver\page1.htm”>

<META HTTP-Equiv=” IBrowse_OnKey49” content=”
Javascript:OnKeyOne();”>

<script>
function OnKeyOne()
{

alert(”the 1 key was pressed”);
}
</script>

</HEAD>
<BODY>

<H2>Key Mapping</H2>
<P>Press the escape key to return to the home page</P>
<P>Press the space key to go to page 1</P>
<P>Press the 1 key will show an alert</P>

</BODY>
</HTML>
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IBrowse_Reboot
This forces the 700 Series Computer or the CK30 Handheld
Computer to reboot.

Syntax
HTTP-Equiv=”IBrowse_Reboot”
content=”cold | warm”

Comments
The device immediately reboots when this tag is encountered. A
warm boot loses any work or files not saved to storage. A cold
boot clears the device of all memory except for the memory
stored on non-volatile media, such as a CompactFlash card, Se-
cure Digital card, or the Flash File System. A cold boot may also
lose certain settings like the wireless network settings. Use the
RegFlushKey() API to help prevent the loss of device specific
settings. Use extreme care before using these tags.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=” IBrowse_Reboot” content=”warm”>
</HEAD>
<BODY>

<H2>Reboot Test</H2>
</BODY>
</HTML>
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IBrowse_SetDate
This updates the system date on the 700 Series Computer or the
CK30 Handheld Computer. If an invalid value is passed, the
date is not changed.

Syntax
HTTP-Equiv=”IBrowse_SetDate”
content=”02/01/2003”

Comments
The date passed in the content tag must be the current GMT
date. in mm/dd/yyyy format. You can use characters other than
the forward slash ( / ) to separate the month, day, and year. Val-
id separators are the backslash ( \ ), forward slash ( / ), comma
( , ), and hyphen ( - ) characters.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_SetDate” content=”02/01/2003”>
</HEAD>
<BODY>

<H2>The date has been updated</H2>
</BODY>
</HTML>
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IBrowse_SetTime
This updates the system time on the 700 Series Computer or the
CK30 Handheld Computer. If an invalid value is passed, the
time is not changed.

Syntax
HTTP-Equiv=”IBrowse_SetTime”
content=”15:35”

Comments
The time passed in the content tag must be the current GMT
time. The device converts the time using the set time zone. This
is useful when there are multiple units spread across different
time zones. The time zone can be set on the device at system
startup and saved by using the RegFlushKey API so you do not
need to reset the time zone on a cold boot. You can use charac-
ters other than a colon ( : ) to separate the hours and minutes.
Valid separators are the colon ( : ) and semicolon ( , ) characters.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_SetTime” content=”15:35”>
</HEAD>
<BODY>

<H2>The time has been updated</H2>
</BODY>
</HTML>
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IBrowse_SIPUp
Note: This is not available for the CK30 Handheld Computer.

You can specify this tag when the onscreen keyboard is required
for data entry. When this tag is specified, the onscreen keyboard
is enabled. The user may still disable the onscreen keyboard by
tapping on the keyboard icon on the navigation bar at the bot-
tom of the screen.

Syntax
HTTP-Equiv=”IBrowse_SIPUp”
content=””

Comments
No text is required in the content tag but you must specify the
content tag for this META tag to work successfully. This tag
affects only the page on which it is placed. Navigating to anoth-
er page disables the onscreen keyboard.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_SIPUp” content=””>
</HEAD>
<BODY>

<H2>The SIP is now displayed</H2>
</BODY>
</HTML>
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IBrowse_UpdateIni
This updates the BROWSE.INI settings and can modify set-
tings on units without having someone physically touch each
unit to enable the new settings. This is also useful if there is a
need to change settings such as password, battery status, and
available menus on a regular basis.

Syntax
HTTP-Equiv=”IBrowse_UpdateIni”
content= Section;Key;Value

Comments
The content section contains the section, key, and value to up-
date in the INI file. A semicolon must separate these values. The
section and key must be valid values for the INI file or an up-
date does not occur. See “INI File Explained” in Chapter 1 for
more information on the valid sections, keys, and values that
you may specify.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=” IBrowse_UpdateIni”
content=”Admin;DisableOptionsMenu;true”>

<META HTTP-Equiv=” IBrowse_UpdateIni”
content=”Admin;Password;123456”>

<META HTTP-Equiv=” IBrowse_UpdateIni”
content=”Display;UpdateInterval;60”>

<META HTTP-Equiv=” IBrowse_UpdateIni”
content=”Display;DisplayBatteryStatus;true”>

<META HTTP-Equiv=” IBrowse_UpdateIni”
content=”Display;DisplaySignalStrength;true”>
<meta http-equiv=“IBrowse_UpdateIni” content=“Keys;AboutKey;0”>
</HEAD>
<BODY>

<H2>INI Update Test</H2>
<P>The Options menu has been disabled</P>
<P>The Password has been changed to 123456</P>
<P>The icons will be updated every 60 seconds</P>
<P>The Battery status will be displayed</P>
<P>The Signal strength will be displayed</P>

</BODY>
</HTML>
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IBrowse_Scanner
This tag is page-specific and only applies to the current page.
When this tag is used alone (not with the IBrowse_ScannerNavi-
gate tag), the bar code data is sent to the keyboard buffer and
any input field that has focus receives the data.

Syntax
HTTP-Equiv=”IBrowse_Scanner”
content=”Enabled | Disabled | AutoTab | AutoEnter”

Comments
The scanner is disabled on a page by default. This tag does not
function if UseWedgeMode is enabled in the BROWSE.INI
file.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_Scanner” Content=”Enabled”>
</HEAD>
<BODY>
<FORM NAME=”FRM1”>
<TABLE>
<TR>

<TD>Barcode:</TD>
<TD><INPUT TYPE=”text” NAME=”FLD1” SIZE=”12”></TD>

</TR>
</TABLE>
</FORM>
</BODY>
</HTML>
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IBrowse_ScannerNavigate
Note: On CK30 Handheld Computers and mobile computers
with Windows Mobile 2003, using this tag to navigate to an
URL only works if the URL is hosted on a web server. This tag
does not work with file-based web pages.

This tag is page-specific and enables the scanner. When there is
a successful scan, iBrowse either navigates to the given URL or
executes the given Javascript function.

Syntax
HTTP-Equiv=”IBrowse_ScannerNavigate”
content= URL | Javascript function

Comments
You can populate the data from the scan into the URL Querys-
tring replacing “%s” with the following pieces of information:
“barcode”, “type”, and “time” in this order. You can also pass
this information to a Javascript function defined on the page.
This tag does not function if UseWedgeMode is enabled in the
BROWSE.INI file.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_ScannerNavigate”
Content=”file://\windows\test.html?barcode=%s&type=%s&time=%s”>

<!-or ->
<META HTTP-Equiv=”IBrowse_ScannerNavigate”

Content=”Javascript:OnScan(’%s’, ’%s’, ’%s’);”>
</HEAD>
<BODY>
........
</BODY>
<SCRIPT>
function OnScan(data, type, time)
{
alert(”Scanned barcode: ” + data + ” type: ” + type + ” time: ” +
time);
}
</SCRIPT>
</HTML>
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Enabling/Disabling Symbologies
This tag updates the scanner configuration either enabling or
disabling the desired symbology.

Syntax
HTTP-Equiv= Symbology Type
content=”Enabled | Disabled”

where Symbology Type is one of the following:

Symbology Name Default

IBrowse_Code39 “Enabled”

IBrowse_Codabar “Disabled”

IBrowse_Code93 “Disabled”

IBrowse_Code128 “Disabled”

IBrowse_I2of5 “Disabled”

IBrowse_PDF417 “Enabled”

IBrowse_Standard2of5 “Disabled”

Comments
These tags are application-specific, they are not limited to the
scope of the current page. When a symbology is enabled or dis-
abled, it remains in that state until changed by sending this tag.

UPC/EAN symbology is enabled by default. See “Symbology
Configuration” on the next page for enabling or disabling the
UPCA, UPCE, EAN8 and EAN13 symbologies.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_I2of5” Content=”Enabled”>
<META HTTP-Equiv=”IBrowse_Code39” Content=”Disabled”>
<META HTTP-Equiv=”IBrowse_Scanner” Content=”Enabled”>

</HEAD>
<BODY>
........
</BODY>
</HTML>
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Symbology Configuration
These tags update the scanner symbology configuration.

Syntax
HTTP-Equiv= Parameter Name
content=”{parameter value}”

Note: Applicable bar code symbology is listed within each pa-
rameter name.

Parameter Name Parameter Value Default

IBrowse_Code39_Format_FullAscii “True”
“False”

“False” (Standard43)

IBrowse_Code39_StartStop_Xmit “True”
“False”

“False”

IBrowse_Code39_StartStop_Chars “DollarSign”
“Asterisk”
“Both”

“Asterisk”

IBrowse_Code39_CheckDigit “Disabled”
“MOD43”
“MOD43_Xmit”
“French_CIP”
“French_CIP_Xmit”
“Italian_CPI”
“Italian_CPI_Xmit”

“Disabled”

IBrowse_Code39_Length 0, 3–50 0

IBrowse_Codabar_StartStop “Disabled”
“LowerABCD”
“UpperABCD”
“LowerABCDTN”
“DC1toDC4”

“Disabled”

IBrowse_Codabar_CLSI “True”
“False”

“False”

IBrowse_Codabar_CheckDigit “True”
“False”
“Disabled”

“Disabled”

IBrowse_Codabar_Length 0, 3–50 6

IBrowse_Code93_Length 0– 50 0

IBrowse_Code128_Include_EAN128_Identifier “True”
“False”

“True”

IBrowse_Code128_CIP128_Active “True”
“False”

“False”
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DefaultParameter ValueParameter Name (continued)

IBrowse_Code128_FNC1_Separator ASCII value 1–127 29

IBrowse_Code128_Length 0–50 0

IBrowse_I2of5_CheckDigit “Disabled”
“MOD10”
“MOD10_Xmit”
“French_CIP”
“French_CIP_Xmit”

“Disabled”

IBrowse_I2of5_Length 0, 2–50 6

IBrowse_PDF417_Buffer_Macro “True”
“False”

“True”

IBrowse_PDF417_Xmit_CtrlHeader “True”
“False”

“False”

IBrowse_PDF417_Xmit_FileName “True”
“False”

“False”

IBrowse_PDF417_Xmit_SegmentCount “True”
“False”

“False”

IBrowse_PDF417_Xmit_TimeStamp “True”
“False”

“False”

IBrowse_PDF417_Xmit_Sender “True”
“False”

“False”

IBrowse_PDF417_Xmit_Addressee “True”
“False”

“False”

IBrowse_PDF417_Xmit_FileSize “True”
“False”

“False”

IBrowse_PDF417_Xmit_Checksum “True”
“False”

“False”

IBrowse_Standard2of5_Format “Identicon”
“Computer_Identics”

“Identicon”

IBrowse_Standard2of5_CheckDigit “True”
“False”
“Disabled”

“Disabled”

IBrowse_Standard2of5_Length 0, 3– 50 6

IBrowse_UPCA “Enabled”
“Disabled”

“Enabled”

IBrowse_UPCE “Enabled”
“Disabled”

“Enabled”

IBrowse_EAN8 “Enabled”
“Disabled”

“Enabled”
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DefaultParameter ValueParameter Name (continued)

IBrowse_EAN13 “Enabled”
“Disabled”

“Enabled”

IBrowse_UpcEan_Addon_Digits “True”
“False”

“False”

IBrowse_UpcEan_Addon_Two “True”
“False”

“False”

IBrowse_UpcEan_Addon_Five “True”
“False”

“False”

IBrowse_UPCA_CheckDigit “True”
“False”

“True”

IBrowse_UPCE_CheckDigit “True”
“False”

“True”

IBrowse_EAN8_CheckDigit “True”
“False”

“True”

IBrowse_EAN13_CheckDigit “True”
“False”

“True”

IBrowse_UPCA_NumberSystem “True”
“False”

“True”

IBrowse_UPCE_NumberSystem “True”
“False”

“True”

IBrowse_UPCA_Reencode_As_EAN13 “True”
“False”

“True”

IBrowse_UPCE_Reencode_As_UPCA “True”
“False”

“False”

IBrowse_EAN8_Reencode_As_EAN13 “True”
“False”

“False”

Comments
These tags are application-specific, they are not limited to the
scope of the current page. When a configuration setting is up-
dated, it remains in that state until changed by sending this tag
again.
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Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_UPCE” Content=”False”>
<META HTTP-Equiv=”IBrowse_EAN8” Content=”False”>
<META HTTP-Equiv=”IBrowse_UpcEan_Addon_Digits” Content=”True”>
<META HTTP-Equiv=”IBrowse_UpcEan_Addon_Five” Content=”True”>
<META HTTP-Equiv=”IBrowse_UPCA_Reencode_As_EAN13” Content=”False”>
<META HTTP-Equiv=”IBrowse_Scanner” Content=”Enabled”>

</HEAD>
<BODY>

........
</BODY>
</HTML>
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IBrowse_ScannerAutoTrigger
This tag is page-specific and only applies to the current page.
When used on a page, the scanner trigger is enabled automati-
cally and allows for continuous and repeated scans.

Syntax
HTTP-Equiv=”IBrowse_ScannerAutoTrigger”
content=”Enabled | Disabled | AutoTab | AutoEnter”

Comments
This tag is currently only supported for the laser scanner. Be
careful with its use, as powering the scanner continuously does
drain the battery very quickly. This tag does not function if Use-
WedgeMode is enabled in the BROWSE.INI file.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_Scanner” Content=”Enabled”>
<META HTTP-Equiv=”IBrowse_ScannerAutoTrigger” Content=”Enabled”>
<META HTTP-Equiv=”IBrowse_ScannerNavigate”

Content=”Javascript:OnScan(’%s’, ’%s’, ’%s’);”>
</HEAD>
<BODY>

........
</BODY>
<SCRIPT>
function OnScan(data, type, time)
{
alert(”Scanned barcode: ” + data + ” type: ” + type + ” time: ” +
time);
}
</SCRIPT>
</HTML>
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IBrowse_PLSeriesLabel_Print
This tag is page-specific and provides the contents of label to
send to an Intermec® PL4 Portable Printer.

Syntax
HTTP-Equiv=”IBrowse_PLSeriesLabel_Print”
content= Label contents

Comments
The value cannot be longer than 1024 characters. Use this tag
with the IBrowse_PLSeriesLabel_Complete tag described on the
next page. To use the PL4 Printer, configure applicable settings
in the INI configuration file.

Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_PLSeriesLabel_Print” Content=” ! 0 200
200 581 1\r\nLABEL\r\nCONTRAST 0\r\nTONE 0\r\nSPEED 3\r\nPAGE-WIDTH
240\r\nBAR-SENSE\r\nTEXT90 4 3 36 288 $22.88\r\nTEXT90 5 2 163 273
SWEATSHIRT\r\nVBARCODE UPCA 2 1 45 139 576 04364503284\r\nTEXT90 7 0
191 511 043645032841\r\nTEXT90 5 0 4 524 COMPARE AT\r\nTEXT90 4 0 30
508 $ 30.00\r\nTEXT90 5 0 115 575 ZD-180-KL\r\nTEXT90 5 2 119 269 ALL
COTTON\r\nTEXT90 7 0 114 389 01/17/98\r\nTEXT90 0 0 208 173
EA00-732-00560\r\nTEXT90 5 0 82 519 ELSEWHERE\r\nBOX 189 358 217 527
1\r\nFORM\r\nPRINT\r\n”>

<META HTTP-Equiv=”IBrowse_PLSeriesLabel_Complete”
Content=”Javascript:PrintingComplete(’%ld’);”>
</HEAD>
<BODY>

</BODY>
</HTML>
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IBrowse_PLSeriesLabel_Complete
This tag is page-specific and specifies the action to perform
when printing of the label is complete. You can either redirect
your application to another page or execute a Javascript function
to define on the same page as this tag. A status code, where 0
represents success is sent from the browser. You must handle this
by setting up the Querystring or function parameter according-
ly, depending upon the method you choose.

Syntax
HTTP-Equiv=”IBrowse_PLSeriesLabel_Complete”
content= URL | Javascript function

Comments
Use this tag with the IBrowse_PLSeriesLabel_Print tag described
on the previous page. To use the PL4 Printer, configure applica-
ble settings in the INI configuration file.

Error/Status Codes

Code Meaning

0 Label printed successfully.

1 Error occurred printing label.

2 Printer is busy.

4 Printer is out of paper or labels.

8 Head\Latch is open.

16 Low battery. Replace or recharge battery before proceeding.

32 Error communicating with the COM Port. Ensure the printer is pow-
ered on and within range. Also, verify whether the [PLSeriesPrinter]
COMPort and BaudRate settings exist and contain correct values in
the INI configuration file.

64 Could not create instance of PL4 Printer control. Ensure the control is
installed and registered.
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Example
<HTML>
<HEAD>

<META HTTP-Equiv=”IBrowse_PLSeriesLabel_Print” Content=” ! 0 200
200 581 1\r\nLABEL\r\................ FORM\r\nPRINT\r\n”>

<META HTTP-Equiv=”IBrowse_PLSeriesLabel_Complete”
Content=”Javascript:PrintingComplete(’%ld’);”>
<1-or→
<META HTTP-Equiv=”IBrowse_PLSeriesLabel_Complete”
Content=” file://\windows\test.html?status=%ld”>

</HEAD>
<BODY>

</BODY>
<SCRIPT>
function PrintingComplete(status)
{
var str;
str = ”Label print completed with a status code of ” + status;
alert(str);
}
</SCRIPT>
</HTML>
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iBrowse Custom Edit ControlB

The iBrowse custom edit control (ITCAXEdit.DLL) is
automatically installed with the iBrowse application. Although
ITCAXEdit is not required, it provides additional functionality
beyond what the standard edit box provides.

Note: The custom edit control is not available for CK30 Hand-
held Computers.
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Using the ITCAXEdit Control on a Web Page
Instantiate the control once for each edit box that needs to go on
a page. Thus, a page with five edit boxes needs to instantiate
ITCAXEdit five times. Do instantiation in the HTML source
where the control is needed.

Example
This source creates a simple page with two edit boxes. The first
one is named IBEAX1 and the second is named IBEAX2.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
<br>
EditBox2 <OBJECT ID=”IBEAX2”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
<br>

</BODY>
</HTML>
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ITCAXEdit Parameters and Functions
You can call all functions using the <PARAM> tag when instan-
tiating the control or from JavaScript code in the HTML.

ALIGNMENT
ALIGNMENT controls the justification of the text in the Edit
Box. JavaScript code can get and set this value. When password
is set to true, the left alignment is used.

Syntax
/*[out, retval]*/ BSTR *pVal
/*[in]*/ BSTR newVal);

Values Action

LEFT Forces the text to left justified — This is the Default

RIGHT Forces the text to right justified

CENTER Centers the text in the edit box

Example
Creates a single edit box with right justification.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”ALIGNMENT” VALUE=”RIGHT”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.ALIGNMENT=’RIGHT’;
</SCRIPT>

</HTML>
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BORDER
BORDER controls whether a border is displayed around the
edit box. JavaScript code can get and set this value.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Displays a border around the edit box — This is the Default

FALSE Does not display a border around the edit box

Example
Creates a single edit box and disables the border.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”BORDER” VALUE=”FALSE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.BORDER = false;
</SCRIPT>

</HTML>
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ENABLESCANNER
ENABLESCANNER controls whether the scanner is enabled
when the edit box gets focus. When the edit box loses focus, the
scanner is disabled. Do not use this if using the META tags to
control scanning. JavaScript code can get and set this value. If
UseWedgeMode is enabled in the INI file, this setting has no
effect on scanning. Note: if JavaScript sets ENABLESCANNER to
TRUE, the scanner is not enabled until the next time the Edit Box
gets focus.

Syntax
/*[out, retval]*/ BSTR *pVal
/*[in]*/ BSTR newVal);

Values Action

ENABLED Enables the scanner when the edit box gets focus and dis-
ables the scanner when focus is lost.

DISABLED Does not attempt to enable or disable the scanner — This is
the Default

AUTOTAB Enables the scanner when the edit box gets focus and dis-
ables the scanner when focus is lost. When a valid scan is
received, the scanner appends a tab to the bar code value.

AUTOENTER Enables the scanner when the edit box gets focus and dis-
ables the scanner when focus is lost. When a valid scan is
received, the scanner appends an enter to the bar code value.

Example
Creates a single edit box and enables the scanner when the edit box gets focus.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”ENABLESCANNER” VALUE=”ENABLED”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.ENABLESCANNER = ENABLED;
</SCRIPT>

</HTML>
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ENABLESIP
Note: This is not available on the CK30 Handheld Computer.

ENABLESIP controls whether the onscreen keyboard (Soft In-
put Panel) is displayed when the edit box gets focus. If enabled,
the onscreen keyboard is disabled when the edit box loses focus.
The user can still put the onscreen keyboard down by tapping
the keyboard icon (shown left) in the command bar at the bot-
tom of the screen. JavaScript code can get and set this value.
Note: if JavaScript sets ENABLESIP to TRUE, the onscreen key-
board is not enabled until the next time the Edit Box gets focus.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Shows the onscreen keyboard when the edit box gets focus
and closes the onscreen keyboard when focus is lost.

FALSE Does not attempt to show or hid the onscreen keyboard —
This is the Default.

Example
Creates a single edit box and shows the onscreen keyboard when the edit box gets fo-
cus.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”ENABLESIP” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.ENABLESIP = true;
</SCRIPT>

</HTML>
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FONTBOLD
FONTBOLD controls whether the text in the edit box is bold.
If enabled, the text is bold, otherwise the text is normal. JavaS-
cript code can get and set this value.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Make the text in the edit box bold

FALSE Do not make the text in the edit box bold - This is the Default

Example
Creates a single edit box with bold text.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”FONTBOLD” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.FONTBOLD = true;
</SCRIPT>

</HTML>
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FONTFIXEDPITCH
FONTFIXEDPITCH controls whether the text in the edit box
is a fixed-pitch font. If enabled, the text is fixed-pitch, otherwise
the text uses the default pitch. JavaScript code can get and set
this value.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Make the text in the edit box a fixed-pitch

FALSE Do not make the text in the edit box fixed-pitch This is the Default

Example
Creates a single edit box with fixed pitch text.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”FONTFIXEDPITCH” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.FONTFIXEDPITCH = true;
</SCRIPT>

</HTML>
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FONTITALIC
FONTITALIC controls whether the text in the edit box is itali-
cized. If enabled, the text is displayed in italic, otherwise, the
text is displayed normally. JavaScript code can get and set this
value.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Make the text in the edit box italicized.

FALSE Do not make the text in the edit box italicized. This is the Default

Example
Creates a single edit box with italics text.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”FONTITALIC” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.FONTITALIC = true;
</SCRIPT>

</HTML>
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FONTNAME
FONTNAME controls which font is used when text is displayed
in the edit box. Any font loaded on the system is a valid parame-
ter. Available fonts are dependant on the hardware used. JavaS-
cript code can get and set the FONTNAME value. If the font
name is not found in the system a system selected font is used.

Syntax
/*[out, retval]*/ BSTR *pVal
/*[in]*/ BSTR newVal);

Values Action

Any font loaded on the mobile device. For example
Tahoma, Courier New, Arial, Lucinda Console,
MS Sans Serif.

Set the text in the edit box to the desired font. The
default is Tahoma.

Example
Creates a single edit box using the Courier New font.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”FONTNAME” VALUE=” Courier New”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.FONTNAME = ’Courier New’;
</SCRIPT>

</HTML>
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FONTSIZE
FONTSIZE controls the size of the text displayed in the edit
box. JavaScript code can get and set the FONTNAME value.

Syntax
/*[out, retval]*/ short *pVal
/*[in]*/ short newVal);

Values Action

Any positive whole numeric value is valid. Values
in the range of 8 to 16 are recommended.

The current font size of the text in the edit box gets
set to the value passed in the default is 10.

Example
Creates a single edit box using a font size of 12.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”FONTSIZE” VALUE=”12”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.FONTSIZE = 12;
</SCRIPT>

</HTML>
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FONTUNDERLINE
FONTUNDERLINE controls whether the text in the edit box
is underlined. If enabled, the text is displayed underlined, other-
wise the text is displayed normally. JavaScript code can get and
set this value.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Make the text in the edit box underlined

FALSE Do not make the text in the edit box underlined. This is the Default

Example
Creates a single edit box with underlined text.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”FONTUNDERLINE” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.FONTUNDERLINE = true;
</SCRIPT>

</HTML>
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MAXLENGTH
MAXLENGTH controls the maximum number of characters
the user can enter into the edit box. Any text already in the edit
box beyond the MAXLENGTH is left as-is. JavaScript code can
get and set this value.

Syntax
/*[out, retval]*/ short *pVal
/*[in]*/ short newVal);

Values Action

0 No limit on the number of characters
that can be entered - This is the Default

Any positive, whole, numeric value The maximum number of characters al-
lowed is set to the numeric value.

Example
Creates a single edit box that allows an entry with a maximum of six characters.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”MAXLENGTH” VALUE=”6”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.MAXLENGTH = 6;
</SCRIPT>

</HTML>
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PASSWORD
PASSWORD indicates that the entered text is sensitive informa-
tion, such as a password. If enabled, instead of showing the text
entered, an asterisk ( * ) is put in place of each character entered.
JavaScript code can get and set this value. When password mode
is enabled, the alignment is always left-aligned.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Replace each character entered with an asterisk ( * )

FALSE Display the text as it is entered - This is the Default

Example
Creates a single edit box to accept a password.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”PASSWORD” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.PASSWORD = true;
</SCRIPT>

</HTML>
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SetFocus
SetFocus sets the focus to a specific edit box. This function can-
not pass as a parameter; you must call it from JavaScript.

Syntax
/*[in]*/ VARIANT_BOOL bSelect);

Values Action

TRUE Focus is set to the desired edit box and the text is highlighted so it is
overwritten by the first key press

FALSE Focus is set to the desired edit box at the end of any existing text

Example
Creates a single edit box and set focus to it.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.SetFocus(1);
</SCRIPT>

</HTML>
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VALUE
VALUE gets or sets the text that is displayed in the edit box.
JavaScript code can get and set this value.

Syntax
/*[out, retval]*/ BSTR *pVal
/*[in]*/ BSTR newVal);

Values Action

“” No text - This is the Default

Any text string Display the text as it is entered - This is the Default

Example
Creates a single edit box with the text “hello.”

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”VALUE” VALUE=”hello”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.VALUE = ’hello’;
</SCRIPT>

</HTML>



iBrowse Custom Edit ControlAppendix B —

87iBrowse User’s Guide

WANTRETURN
WANTRETURN allows the edit control to hold multiple lines.
If enabled, instead of performing the default enter key function-
ality, the enter key adds a newline to the edit box so further text
is added to the next line. JavaScript code can get and set this
value.

Syntax
/*[out, retval]*/ VARIANT_BOOL *pVal
/*[in]*/ VARIANT_BOOL newVal);

Values Action

TRUE Pressing the enter key creates a new line in the current edit box

FALSE Display the text as it is entered - This is the Default

Example
Creates a single edit box to accept a password.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>

<PARAM NAME=”PASSWORD” VALUE=”TRUE”
</BODY>

<!- - OR - - >
<SCRIPT LANGUAGE=”JSCRIPT”>

IBEAX1.PASSWORD = true;
</SCRIPT>

</HTML>
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ITCAXEdit Events
All events are trapped using JavaScript code in the HTML. This
allows for the web page to react to certain user input in a way
that is not possible with the standard <input type=“text”> tag.
All of these events are optional. You do not need to implement
these on every web page but instead you should implement these
on an as-needed basis.

OnChange
The OnChange event is fired when the value of the ITCAXEdit
control has changed. No return value is required.

Syntax
Void OnChange( void )

Parameter Description

void No parameters

Example
Displays and alert every time the value in the control is changed.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnChange( )”>
alert(’The edit box value has been changed’);

return 0;
</SCRIPT>

</HTML>
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OnClick
The OnClick event is fired when the user clicks on the
ITCAXEdit control. No return value is required.

Syntax
Void OnClick(int x int y)

Parameter Description

x An integer that represents the x coordinate of the tap relative to
the upper-left corner of the edit box in pixels.

y An integer that represents the y coordinate of the tap relative to
the upper-left corner of the edit box in pixels

Example
Changes the value of the edit box based on where the tap occurred in the edit box.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnClick(x, y)”>
if (x < (IBEAX1.Width / 2))

IBEAX1.Value = ’LEFT’;
else

IBEAX1.Value = ’RIGHT’;
return 0;

</SCRIPT>

</HTML>
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OnFocus
The OnFocus event is fired when ITCAXEdit control receives
focus. No return value is required.

Syntax
Void OnFocus(void)

Parameter Description

void No parameters

Example
When the edit control gets focus, set the value to the default.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnFocus()”>
IBEAX1.Value = ’Default’;

</SCRIPT>

</HTML>
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LostFocus
The LostFocus event is fired when ITCAXEdit control loses fo-
cus. No return value is required.

Syntax
Void LostFocus(void)

Parameter Description

void No parameters

Example
When the edit control loses focus, display an alert.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnLostFocus()”>
alert(’The control just lost focus’);

</SCRIPT>

</HTML>
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OnKeyDown
The OnKeyDown event is fired when a key on the physical or
onscreen keyboard is pushed and the ITCAXEdit control has
focus. No return value is required.

Syntax
Void OnKeyDown(int key)

Parameter Description

key An Integer value that holds the ASCII code of the key pressed.

Example
When a key is pressed display an alert.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnKeyDown()”>
alert(’A key down was received’);

</SCRIPT>

</HTML>
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OnKeyUp
The OnKeyUp event is fired when a key on the physical or ons-
creen keyboard is released and the ITCAXEdit control has focus.
No return value is required.

Syntax
Void OnKeyUp((int key)

Parameter Description

key An Integer value that holds the ASCII code of the key pressed.

Example
When a key is released, display an alert.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnKeyUp()”>
alert(’A key up was received’);

</SCRIPT>

</HTML>
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KeyPress
The OnKeyPress event is fired when a key on the physical or
onscreen keyboard is pressed and the ITCAXEdit control has
focus. To leave the key value as-is, set the return value to 0, .To
cancel the key press or have another key value to replace the val-
ue passed, set the value to –1.

Syntax
int OnKeyPress(int key)

Parameter Description

key An Integer value that holds the ASCII code of the key pressed.

Example
Create two edit controls and trap the tab key so it sets focus to the next edit control.

<HTML>
<HEAD></HEAD>
<BODY>
EditBox1 <OBJECT ID=”IBEAX1”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
EditBox2 <OBJECT ID=”IBEAX2”
CLASSID=”CLSID:D8A6AACE-0F02-4440-8F07-64CF68F33DE9” WIDTH=”50”
HEIGHT=”25”>
</BODY>

<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX1” EVENT=”OnKeyPress()”>
if (key == 9)
{

IBEAX2.SetFocus(1); // set focus to the second control
Return -1; // no need to pass the key back to

the control
}
return 0; // pass the key value along a

</SCRIPT>
<SCRIPT LANGUAGE=”JSCRIPT” FOR=”IBEAX2” EVENT=”OnKeyPress()”>

if (key == 9)
{

IBEAX1.SetFocus(1); // set focus to the first control
Return -1; // no need to pass the key back to

the control
}
return 0; // pass the key value along a

</SCRIPT>

</HTML>
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iBrowse NavigationC

The following information pertains to the CK30 Handheld
Computer but can apply to the 700 Series Computer, if desired.
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Keyboard Navigation
To aid in navigation on devices with no touch screen iBrowse
contains many specific features to allow navigation though the
keyboard.

S The IBrowse_OnKey Meta tag maps key values on a page-by-
page basis to navigate to a specific web page or run a Javas-
cript function on the current page. With this, you can assign
each link available on a page a navigation key, and can set up
a key to navigate back to the previous page. See the sample
web pages installed to the “\windows\ibrowse” directory for
examples.

S [F1] Help option. Through the INI file, you can set iBrowse
to set the [F1] key to bring up a custom help page. This page
could contain generic instructions on how to use iBrowse or a
list of links to help bring up other windows such as Options,
About, or Exit. See “Reserved HREF Values” on the next page
for more information on HREF values. A default help page,
F1HELP.HTML, is installed to the “\windows\ibrowse” di-
rectory.

S Persistent key remapping through the [Keys] section of the
INI file maps keys permanently to features such as Return to
the Home Page, Options screen, About screen, and Exit
screen.

S On CK30 and Windows Mobile 2003 devices, you can use
arrow keys to scroll up and down, left and right when scroll
bars are present. On a page with edit boxes, you can toggle
between the arrows key scrolling in the edit box and scrolling
the page by pressing the enter key. For example, when a page
loads and if the Edit box has focus, pressing the arrow keys
scroll the cursor in the edit box. If the Enter key is pressed,
the cursor leaves the edit box and pressing the arrow keys
scroll the entire web page. You can avoid this need to scroll
the web page if all pages are designed to fit on one screen.
When the Edit box has focus, press [Enter], then [Tab] to tab
between multiple edit boxes.
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Reserved HREF Values
To allow web pages to be more dynamic and affect some control
over the application, certain HREF values are reserved for use in
the iBrowse application.

The reserved values are:

S IBROWSE_ABOUT_SCREEN
Brings up the iBrowse About screen.

S IBROWSE_OPTIONS_SCREEN
Brings up the iBrowse Option Screen. The password screen
appears and prompts for a valid password before accessing the
screen.

S IBROWSE_HOME_SCREEN
Navigates to the Home page specified in the INI file.

S IBROWSE_EXIT_SCREEN
Brings up the iBrowse Exit Screen. The password screen
prompts for a valid password before accessing the screen.

S IBROWSE_REFRESH_PREVIOUS_SCREEN
Attempts to navigate to the last screen that was either success-
fully or unsuccessfully navigated.

Example:
<html>

<head>
<meta http-equiv=”IBrowse_OnKey49” content=”IBROWSE_HOME_SCREEN”>
<meta http-equiv=”IBrowse_OnKey50” content=”IBROWSE_ABOUT_SCREEN”>
<meta http-equiv=”IBrowse_OnKey51” content=”IBROWSE_OPTIONS_SCREEN”>
<meta http-equiv=”IBrowse_OnKey52” content=”IBROWSE_EXIT_SCREEN”>

</head>
<body>
<b><font size=”5”>IBrowse Help Page</font></b>

<a href=”IBROWSE_HOME_SCREEN”>1) Home Page</a><br>
<a href=”IBROWSE_ABOUT_SCREEN”>2) About Screen</a><br>
<a href=”IBROWSE_OPTIONS_SCREEN”>3) Options Screen</a><br>
<a href=”IBROWSE_EXIT_SCREEN”>4) Exit IBrowse</a><br>

</body>

</html>



C iBrowse NavigationAppendix —

98 iBrowse User’s Guide



99iBrowse User’s Guide

Application Version HistoryD
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Version 1.20
S Added support for CK30 Handheld Computers with Stan-

dard OS and 700 Series devices with Windows Mobile 2003.

S Added checks to provide extended feedback to the user about
network errors. [ see ibrowse Connectivity Messages in Chapter
1, “About iBrowse” ]

S Added INI based persistent Keymappings to provide hotkeys
to various functionality in iBrowse (Exit, options, about,
Home) [ see INI File Explained — Keys Section in Chapter 1,
“About iBrowse” ]

S Added F1Helpkey abilities so that when the F1 key is pressed
a web page will be displayed with help for the user. [ see INI
File Explained — Admin Section in Chapter 1, “About
iBrowse” ]

S Added a notfoundpage option that will display a predefined
web page when the browser could not successfully navigate to
the appropriate page. [ see INI File Explained — Admin Sec-
tion in Chapter 1, “About iBrowse” ]

S Added Predefined links to provide hotkeys to various func-
tionality in iBrowse (Exit, options, about, Home) [ see Re-
served HREF Values in Appendix C, “iBrowse Navigation” ]

S IBrowse_OnKey key remapping is only limited by memory
and the number of keys available.

S iBrowse no longer requires a data storage card for devices that
contain a Flash File Store.
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Version 1.10
S Added support for custom META tags. See “Custom META

Tags for iBrowse” in Appendix A for more information.

S Changed the way the onscree keyboard works so that it does
not “flash” up on the screen when an edit box was selected
but the keyboard icon was not tapped.

S Temporary fix was added for a Bluetooth issue. After a sus-
pend/resume, the Bluetooth stack is reloaded and it brings
the command bar to the foreground. iBrowse now looks for a
message that indicates the stack is reloaded and then disables
the command bar again, but this leaves a short amount of
time where a user could get into the system.

S Added built-in support for scanning. See “Custom META
Tags for iBrowse” in Appendix A for more information

S Added built-in support for the Intermec® PL4 Portable Print-
er. See “Custom META Tags for I_Browse” in Appendix A for
more information.

S Added indicators for battery status and signal strength.

S Added ability to disable some of the icons and menu options.

S Added support for the ITCAXEdit ActiveX control.
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Version 1.01
S Added support for the special TE Bundle.

S Added code to ensure that iBrowse was still full screen after
applications opened on top of iBrowse are closed.
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